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Hüdraulilise löögi arvutus ringvõrgus (Bentley HAMMER) 

Eelnevalt oled õppinud, kuidas luua ning arvutada üht lihtsat toru mudelit. Samuti peaksid oskama 
kirjeldada põhikarakteristikuid läbi tarkvara graafilise liideste. Järgnevalt vaatame mudelit, mis on 
eelnevalt loodud WaterGEMS tarkvaras. HAMMER võimaldab importida ka EPANET mudeleid. Ka 
seekord viid läbi hüdraulilise löögi arvutused kolmes etapis: 

1) Impordid statsionaarse WaterGEMS mudeli Bentley HAMMER tarkvarasse ning kontrollid selle 
paikapidavust. 

2) Valid löögi arvutuse skeemi. Viid läbi arvutuse. 
3) Annoteerid tulemuste kaarti ning profiile ja löögi ajaloo graafikuid tarkvara visualiseerimise 

töövahendeid kasutades. 

Statsionaarse mudeli import ning kontroll 

Ava WaterGEMS mudel alljärgnevat protseduuri järgides: 

1) Riba pealt: File > Open. Mine asukohta: Program Files (x86)/Bentley/HAMMER/Lessons 
kataloogi ning ava fail Lesson2_WaterGEMS.wtg. 

2) Kliki Compute Initial Conditions nupul. Sulge User Notifications dialoog. 

 

Vaadates statsionaarset mudeli arvutuslike väärtusi, näeme, et peaveetoru kannab ligikaudu 210 l/s 
vett reservuaari Res2 (kõrgusmärgil 456 m) ning alumisse võrguossa (hargnemine ligikaudu 400 m 
pumbajaamast) ligikaudu 265 l/s. Pumbajaama läheduses olev lõik on madalamal kõrgusmärgil. Samas 
lõpuots on jällegi kõrgemal. Eesmärk on leida löögi võimalikud olukorrad ning soovitada 
kaitseseadmete valik. 

3) Enne kui käivitada arvutuse, pead määrama profiilid ning huvipakkuvad punktid. 
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4) Vali: Analysis > Calculation Options. Tee topelt klikk Transient Solver > Base Calculation Options 
real. Kliki rea Report Points Collection lõpus oleval (…) ikoonil. Lisa sõlmed PMP1D:PMP1, 
P1:J1, P2:J1, P2:J2, P8:J2, P27:J19, P28:J19, P47:J34 ning P50:J37 nimekirja Selected Items 
(seda õppisid sa tegema ka eelmises harjutustunnis). 

 

Kliki OK. 

Märkus: Bentley HAMMER teeb löögi ajaloo graafikud toru otsa punktides, mis on määratud 
kõige lähemal oleva toru otspunktiga ning tähistatakse kui Toru_Ots_Punkt:Sõlm. Selleks, et 
saaksid täieliku ülevaate, mis valitud sõlmes toimub, pead uurima igat ühenduspunkti, mis 
sellest sõlmest lähtub (näiteks selle näite juures P1:J1 ning P2:J1 sõlme J1 jaoks). 

5) Muuda parameeter Run Duration = 160 sekundit. Sulge aken Calculation Options. 
6) Riba pealt: View > Profiles. 
7) Loo kolm uut profiili: 

1. Loo profiil nimega Path1 ning lisa torud: PMP1D, P1, P2, P3, P4, P5, P6 ning P7. 
2. Loo profiil nimega Path2 ning lisa torud: PMP1D, P1, P2, P8, VLV1U, VLV1D, P9, P10, P14, 

P48, P49 ning P50. 
3. Loo profiil nimega Path3 ning lisa torud: PMP1D, P1, P2, P8, VLV1U, VLV1D, P9, P15, P22, 

P24, P28, P30, P46 ning P47. 

 

8) Sulge Profiles aken. 
9) Kliki Compute Initial Conditions nupul. Sulge Calculation Summary. 
10) Kliki nupul Compute. Sulge Transient Calculation Summary aken. 
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11) Kliki riba pealt: Analysis > Transient Results Viewer. Prindi graafikud maksimaalsete/ 
minimaalsete löögilainete väärtuste kohta kõikide radade Path1, Path2 ning Path3 kohta. Raja 
Path1 omad peaksid välja nägema alljärgneva pildi kohaselt: 

 

12) Kliki paanil Time Histories ning vali Time History > PMP1D:PMP1, vali Graph Type > Hydraulic 
Grade and Flow ning kliki nupul Plot, et genereerida hüdraulilise löögi ajalugu kirjeldav graafik 
pumbajaama juures. Statsionaarses režiimis ei tohiks olla märgatavaid muutusi ajas. 

Tulemused, mida Bentley HAMMER esitab, ei näita statsionaarses režiimis erinevusi rõhus ega ka 
vooluhulgas aja möödudes. Sellest võib järeldada, et algsed ääretingimused on kehtivad. Võid nüüd 
edasi minna ning jätkata hüdraulilise löögi analüüse võrgus. 

Juhul kui tulemus statsionaarses režiimis on väga hüplev, võib tarkvara tulemuste failis (*.out) esitada 
lööki ajahetkel null. Selles saab tavaliselt üle, kui statsionaarne mudel käivitada uuesti ning kasutada 
väiksemaid veapiire. 

Hüdraulilise löögi sündmuse valik mudelisse 

Eelmises harjutustunnis käsitleti lööki, mis tekkis äkilise elektrikatkestuse tagajärjel. Selles tunnis õpid 
sa simuleerima lööki, mis tuleneb pumba seiskumisest ning taaskäivitumisest. Ehkki elektrikatkestus 
on tavaliselt kõige hullem stsenaarium võib ette tulla olukordi, kus enneaegne pumba käivitamine 
(löögienergia pole toru hõõrde tagajärjel sumbunud) võib põhjustada suuremaid surveid, kui esialgne 
elektrikatkestus. 

Hüdraulilise löögi analüüs 

Selleks, et genereerida löögi sündmust pumba kiire seiskumise ning käivitumise tagajärjel, pead sa 
määrama vajalikud pumba karakteristikud, mis määravad pumba kiirused, millal see seiskub ning 
taaskäivitub. Üheks võimaluseks on seda teha läbi pöörete-arvu reguleerimist võimaldava pumba. 



WATER | Hüdraulilise löögi arvutus ringvõrgus (HAMMER) | Raido Puust | 2024 4/14 

 

Analüüs kaitsesüsteemideta 

1) Tee topelt-klikk elemendil PMP1. Aknas Properties Editor, sektsioon Transient (Operational), 
muuda parameetrit Pump Type (Transient) = Variable Speed/Torque. 

2) Sa saad kasutada kas parameetrit Speed (pöörete arv) või Torque (võimsus), et määrata pumba 
töögraafik. Selles õppetunnis vaatame pumba seadistust Speed parameetri näitel. 

3) Sektsioonis Transient (Operational), kliki Operating Rule hüpikmenüül ning vali <Edit…>. 
Avatakse dialoog Patterns. 

4) Vali kataloog Operational (Transient, Pump) ning kliki New nupul. Paanil Pattern (dialoogi 
paremas osas), kliki New nupul ning lisa uus rida graafiku tabelisse. Sisesta väärtus Multiplier 
= 1 ning Time from Start = 5.0. Lisa ka teised tabeli read järgneva joonise kohaselt ning võid 
seejärel klikkida nupul Close, et dialoog sulgeda. 

 

5) Sektsioonis Transient (Operational) kliki nimekirjal Operating Rule ning vali Operational 
(Transient, Pump) – Pattern 1. 

6) Riba pealt: Analysis > Options. Muuda tabeli väärtust Generate Animation Data = True. Sul 
läheb hiljem vaja animatsioonis andmestikku, kui soovid tulemusi ekraanil animeerida. Sulge 
Calculation Options aken. 

7) Kliki nupul Compute. Sulge dialoogid Transient Calculation Summary ning User Notifications. 
8) Kliki riba peal: Analysis > Transient Results Viewer. 
9) Vali punkt PMP1D:PMP1 ning Graph Type > Hydraulic Grade and Flow (see on pumba 

survepoolne punkt). See peaks välja tulema alljärgneva pildi kohaselt ning sellest võib 
järeldada järgmist: 

• Peal pumba äkilist seiskumist, kukuvad rõhk ning vooluhulk järsult, sellele järgneb kiire 
rõhu kasv (umbes 15 s), peale vooluhulga naasmist pumbajaama, mille tõttu õhukotid 
trassi kõrgpunktides varisevad kokku. Pumba ees olev tagasilöögi klapp hoiab pumba 
survepoolel vooluhulga nullina nii esimese kui kõigi järgnevate rõhu kõikumiste jooksul 
(kuniks pumba taaskäivitumiseni). 



WATER | Hüdraulilise löögi arvutus ringvõrgus (HAMMER) | Raido Puust | 2024 5/14 

 

• Maksimaalne löögi surve, mis tekib pumba taaskäivitamisel, ei ületa maksimaalset survet, 
mis tekib umbes 10 sekundit peale esialgset elektrikatkestust. Seda seetõttu, et pumba 
poolt antav vooluhulk ei lase õhukottidel taastekkida, mis saaksid seejärel kokku variseda. 

• Süsteem jõuab uue statsionaarse olekuni peale 50 sekundit ning on enam-vähem täielikult 
stabiliseerunud uuele statsionaarsele olekule 90 sekundi pärast. 

• Nii nagu eeldatud, lõplik statsionaarne režiim on sarnane algsele statsionaarsele režiimile. 

 

10) Loo ka maksimaalsete ning minimaalsete survejoonte graafikud kõikide radade (Path1, Path2, 
Path3) jaoks. Raja Path3 juures peaks see välja nägema alloleva pildi kohane: 

 

Neilt piltidelt saame teha järgmised tähelepanekud: 

• Pea poole toru pikkuse osas ilmnevad rõhud, mis jäävad allapoole õhurõhust. Täielik vaakumi 
rõhk (-10 m) ilmneb torustiku põlvel (pumbajaama läheduses) ning võrgu kohalikus kõrgemas 
punktis.  

• Maksimaalsed löögi surved on ligikaudu 100% statsionaarses režiimis olevatest suuremad (pea 
kogu raja Path3 ulatuses). Tegemist on üsna märkimisväärse tulemusega, kui arvestada torude 
survetugevusklassi piirväärtust, eriti kui tegemist on vanemate torudega. Mõistlik oleks 
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graafikul näidata torustiku töö- ning tugevusklassi piirkonda, mille põhjal on lihtne teha 
kokkuvõtteid, kas toru kannatab need kõrged rõhud välja. 

11) Eksperimenteeri süsteemi tundlikkusega, võttes arvesse pumba automaatset töökatkestust 
ning taaskäivitumist: 

• Vali pumbale erinevad töögraafikud. Näiteks proovi 10 sekundilist töögraafikut. Kui kiiresti 
vooluhulk kahaneb nulli? Miks? 

• Vali erinevad ajavahemikke pumba seiskumisele ning taaskäivitumisele. Mis juhtub, kui sa 
üritad käivitada pumba hetkel, kui rõhk on minimaalne, kasvav või kõrgeim? 

12) Määra kõige kiirem pumba töögraafik ning väikseim seisakuaeg, mis ei põhjusta liiga suuri 
löögist tingitud rõhkusid mistahes süsteemi punktis. Kuna maksimaalsed löögi jooned sõltuvad 
neist kahest väärtusest, võib esineda ka mitmeid lahendeid. Sa võid dokumenteerida oma 
lahendi tööeeskirja näol, mis talletatakse pumba jaamas ning kontrollid selle täpsust jooksvalt. 

Märkus: Auru või õhu maht, mis esitatakse sõlme kohta, on summaarne väärtus, mis kogutakse 
kokku igast sõlme ühenduspunktist. Kuna toru võib omada mahtusid ka mujal, kui selle 
otspunktides, ei pruugi toru mahud ühtida sõlme omadega. Juhul, kui sõlmega on ühendatud 
kahest torust enam torusid, siis ei pruugi maht, mis esitatakse rajajoonel kattuda mahuga, 
mida näidatakse sõlme ajaloos või Drawing Pane aknas, kuna üks rada saab omada vaid kahte 
toru, mis on ühendatud vastava sõlmega. 

13) Tulemused näitavad, et süsteemis ilmnevad märgatavad rõhud. Peale animatsioonide 
läbivaatamist, selgub et: 

• Kõrged rõhud tekivad märgatavate aurukotikeste kokku varisemisel lokaalsetes torustiku 
kõrgemates punktides. Vaadates punktide P2:J1 ning P27:J19 ajalugu, leiab kinnitust 
tõsiasi, et aurukotikesed varisevad kokku just neil hetkedel. 

• Pump taaskäivitub 25 või 20 sekundit peale seiskumise algust ning samal hetkel jõuab ka 
suurem rõhulaine õhukotikese kokku varisemise tõttu sõlmest J1 pumbajaama. See 
rõhulaine sulgeb pumba tagasilöögi klapi mõneks ajaks, kuniks see jõuab oma 
koguvõimsuseni ja täispööreteni umbes 30ndal sekundil. 

• Löögi rõhulained liiguvad üle terve süsteemi, peegeldudes reservuaaridest, tupikutest ning 
mahutitest. Tulemuseks on keerukas, kui põhimõtteliselt perioodiline häiritus pumbale, 
kui viimane üritab saavutada statsionaarset režiimi. 

• Nii nagu ka eeldatud, lõplik statsionaarne survekõrgus ning vooluhulk on sarnased 
esialgsele statsionaarsele režiimile. 
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Analüüs surve kaitseseadmetega 

Sul on võimalik valida terve rea kaitseseadmete vahel, mis kontrollivad kõrgeid ja madalaid löögist 
tingitud rõhkusid peamagistraalil (Path1) ning jaotusvõrgus (Path2 ja Path3). Bentley HAMMER 
võimaldab efektiivselt valida alternatiivseid kaitseseadmeid, et vaadata, kuidas mingi seade mõjutab 
torustikus olevaid rõhkusid. Selles näites püüad sa kaitsta tervet süsteemi kahe surve-kontrolli 
seadeldisega: 

• Hydropneumatic Tank sõlmes J1, mis on sarnane sellele, mida kasutasid eelmises 
harjutustunnis. 

• Lihtne vooluhulka läbi laskev surve mahuti või väljalasketoru sõlmes J19. Kombineeritud 
õhuväljalaske klapp võiks samuti tulla kõne alla, kui külmumine või maaomanduse maksumus 
pole probleemiks. 

Mudel on juba eelnevalt seadistatud, kus kaitseseadmed on lisatud läbi Active Topology alternatiivi. 
Joonisel, pane tähele halle torusid ning sõlmesid, mis külgnevad sõlmede J1 ning J19 piirkondadega. 

 

Active Topology on viis modelleerida mitu erinevat võrgu skeemi ühes ja samas mudelis. Sa saad 
markeerida elemente mitte aktiivseteks teatud stsenaariumite jaoks aga teiste stsenaariumite jaoks 
aktiivseteks. 
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Me loome uue Active Topology alternatiivi, milles on uus Hydropneumatic Tank ning Surge Tank (ning 
nendega külgnevad torud) aktiivsed ning elemendid, mis neid asendavad (J1 ning J19 ja nendega 
külgnevad torud) mitte aktiivsed. 

1) Kliki riba pealt: Analysis > Alternatives. 
2) Alternatives aknas, laienda Active Topology rida, tee parem klikk Base Active Topology peal 

ning vali New > Child Alternative. Nimeta see uus alternatiiv ümber kui Kaitseseadmetega. 

 

3) Sulge dialoog Alternatives. Kliki: Analysis, vali Scenarios. Kliki nupul New ning vali Child 
Scenario. Nimeta see ümber kui Kaitseseadmetega. 

 

4) Tee topelt klikk stsenaariumil ning Properties aknas muuda ära Active Topology Alternative > 
Kaitseseadmetega. Dialoogis Scenarios, veendu, et Kaitseseadmetega rida oleks valitud ning 
kliki nupul Make Current . 

Nüüd, kus stsenaarium on endiselt aktiivne, teostatakse mistahes active topology seadete 
muudatused just stsenaariumi Kaitseseadmetega all (ja vastava alternatiivi all). 

5) Riba pealt: Tools > Active Topology Selection. Kuvatakse nupupaan Active Topology Selection. 

 

6) Nupp Add teeb elemendi mitte aktiivseks. 
7) Nupp Remove teeb elemendid aktiivseteks.  
8) Vali nupp Add ning kliki järgmistel elementidel, et teha need mitteaktiivseteks: J1 ja J19. 
9) Kliki nupul Remove ning kliki järgmistel elementidel, et teha need aktiivseteks: P1-1, HT-1, P2-

1, ST-1, P25-1, P24-1, P26-1, P27-1 ja P28-1. 
10) Võrk peaks nüüd välja nägema alljärgnev: 
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11) Kliki nupul Done (nupuribal Acitve Topology Selection). 
12) Kuna me kasutame erinevaid elemente, peame uuendama ka punktide nimekirja ning rajajooni 

(profiile). 

• Real Report Points Collection , eemalda punktid P1:J1 ning P2:J1 nimekirjast Selected Items. 
Lisa punktid P1-1:HT-1 ja P2-1:HT-1. 

• Kustuta kõik kolm profiili. Loo uued profiilid: 
o Loo profiil nimetusega Rada1 ning lisa torud: PMP1D, P1, P2-1, P3, P4, P5, P6 ja 

P7. 
o Loo profiil nimetusega Rada2 ning lisa torud: PMP1D, P1-1, P2-1, P8, VLV1U, 

VLV1D, P9, P10, P14, P48, P49 ning P50. 
o Loo profiil nimetusega Rada3 ning lisa torud: PMP1D, P1-1, P2-1, P8, VLV1U, 

VLV1D, P9, P15, P22, P24-1, P28-1, P30, P46 ning P47. 
o Sulge Profiles dialoog. 

13) Kliki nupul Compute Initial Conditions. Sulge dialoog Calculations Summary. 
14) Kliki nupul Compute. Sulge dialoogid Transient Calculation Summary ning User Notifications. 
15) Peale analüüsi lõppu vali: Analysis > Transient Results Viewer. Kasuta Profile nuppu, et luua 

graafikud löögi surve joontele radadel Rada1, Rada2 ja Rada3. Vastav graafik peaks Rada3 
juures välja nägema alljärgneva pildi kohane: 
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• Mitte üheski torustiku punktis ei esine õhurõhust madalamaid rõhkusid (piki Rada3). 
• Maksimaalsed löögi rõhud on torustiku teises pooles enam vähem võrdväärsed 

statsionaarses olekus olevatega (Rada3). Hoides löögist tingitud rõhkusid väiksemates 
vahemikes vähendatakse kaebuste hulka ning see võib olla väga oluline teatavatele 
tööstustele. 

16) Võrdle surve graafikuid erinevate parameetrite korral (ühes kaitseseadmetega ning ilma): 

• Võimalik, et võid vähendada mahuti (Hydropneumatic Tank ning Surge Tank) suurust ning 
ühes sellega ka selle maksumust, kuniks oled leidnud sobivate parameetritega 
kaitseseadme, mis hoiab löögi rõhkusid lubatavas vahemikus. 

• Võid proovida Hydropneumatic Tank ning Surge Tank asemel kasutada ka kahe-
süsteemsest või kombineeritud Air Valve (õhuväljalaske klapp) sõlmedes J1 ning J19. 

17) Enne kaitseseadmete lõpliku soovitamist peaksid sa teostama ka teiste võimalike löögi 
põhjuste analüüsi. 
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Värvi-kaardid, profiilid ning punktide ajalood 

Löögi-kontrolli strateegia väljatöötamisel on kõige huvipakkuvamad maksimaalsed olukorrad. Bentley 
HAMMER omab sisseehitatud visualiseerimismoodulit, mis suudab esitada maksimaalseid ning 
minimaalseid simuleeritud vooluhulkasid, surveid, rõhkusid ning mahtusid (aur või õhk) terve 
torusüsteemi kohta. Sa saad värvikoodis esitada sõlmi ning torusid. 

Selles osas vaatamegi lähemalt värvikoodi seadistamist, mis võimaldab luua väga head ülevaadet 
andva presentatsiooni. 

1) Jätka samast failist, kus on teostatud kaitsesüsteemiga arvutus. 
2) Juhul, kui oled mingit parameetrit vahepeale muutnud, kliki uuesti Compute Initial Conditions. 

Sulge dialoog Calculation Summary. 
3) Kliki seejärel ka nupul Compute. Sulge dialoogid Transient Calculation Summary ning User 

Notifications. 
4) Riba pealt: Analysis vali Transient Thematic Viewer. Vaikimisi kasutab tarkvara parameetrit 

Maximum Head ning torude kui sõlmede värvimisel. 
5) Paanil Pipes kliki nupul Calculate Range ning vali Full Range. See seab automaatsed piirid 

maksimaalsele ning minimaalsele väärtusele hetkel aktiivse parameetri Field Name: osas. 
6) Dialoogi paremal pool kliki nupul Initialize . See jaotab automaatselt parameetrite vahemiku 

etteantud arvu (Steps) järgi osadeks ning seob igale neist ka värvitooni. 
7) Kliki nupul Ramp . Nupp Ramp valib värvid nii, et esimese ja teise värvitooni vahel moodustuks 

sujuv üleminek (gradient). Kliki kolmandal värvikastil ning vali sinna kollane värv. Kliki neljandal 
värvikastil ning vali sinna oranž. Sinu paan Pipe peaks nüüd nägema välja alloleva pildi kohane. 

 

8) Kliki nupul Apply. Sinu võrk peaks nüüd nägema välja alljärgnev: 
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9) Dialoogis Transient Thematic Viewer aknas kliki paanil Nodes Muuda Field Name > Pressure 
(Maximum Transient). 

10) Tee parem klikk ühikul kPa nimel (rea Minimum kõrval) ning vali Units and Formatting. 
11) Dialoogis Set Field Options vali Unit = bars. 

 

Kliki OK. 

12) Kliki Calculate Range nupul ning vali Full Range. 
13) Kliki nupul Initilize. Kliki esimese rea värvikastil ning vali helesinine. Kliki viimase rea värvikastil 

ning vali tume sinine. Kliki nupul Ramp. Dialoog peaks nüüd välja nägema alljärgnev. 
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14) Kliki nupul Apply. Sa saad vähendada Transient Thematic Viewer akent, kuid ära sulge seda; 
see peab jääma avatuks nii kaua, kuni soovid, et elemendid oleksid selle järgid värvitud. Sinu 
mudel peaks nüüd välja nägema alljärgnev: 

 

15) Proovi erinevaid väärtusi torude ja sõlmede esitamiseks, et värvikood annaks parema ülevaate. 
Näiteks võid proovida teha veel alljärgnevat: 

• Sa võid muuta iga vahemiku väärtust. Kui teha näiteks esimesed kaks vahemikku oluliselt 
suuremad, siis on ka rohkem torusid rohelist värvi, esitades surved süsteemist, mis 
langevad tavaolukorra ja kõrgete vahemiku. 

• Torude osas võid värvida tumesinisega need kohad, kus on alarõhu ohud, misjärel saad 
graafiliselt kätte kohad, kus on võimalikud ohud reostuse sisenemiseks torustikku. 
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• Sõlmede osas võid eksperimenteerida protsentidega, mis esitatakse kollase ning oranži 
värviga, kus on normaalne töörõhk või löögi piirlimiit. 

• Värvikoodis kaartide esitamine annab ülevaatlikku pildi äärmuslike olukordade 
hindamiseks. Seda kaarti saab võrrelda nüüd profiilidega ja ajalooga (või vastavate 
animatsioonidega). 

Mõned alamlõigud kannatavad samuti kõrgete survete all. Näiteks vaadates sõlmede tabelit, näeme, 
et sõlm J34 on kõige kõrgemal süsteemis asetsev punkt ning seal on kõige väiksem löögist tingitud 
rõhk; samas süsteemi madalaimas punktis, sõlm J37, on löögist tingitud rõhk maksimaalne. 
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